
IDFEdit Help Index

What is IDFEdit?
IDFEdit is used to create Instrument Definition Files (IDFs) which describe how to map General MIDI 
data to play on a non-General MIDI instrument. A single IDF file can contain descriptions for more 
than one instrument. This is useful for creating one file which describes a related class of instruments;
for example, a wave table synthesizer with several memory configurations. These files are used by 
the MIDI Mapper and are installed by the user via the Multimedia Control Panel applet.

What is an Instrument?
In an IDF file an instrument is used to describe the mapping for a MIDI device.    MIDI devices include 
keyboard, synthesizers, digital samplers, drum machines, and internal MIDI devices such as the OPL 
chip set, or wave table cards.

Commands
File menu
Edit menu
View menu
Help menu



File menu commands

The File menu offers the following commands:

New Create a new IDF file.
Open Open an existing IDF file.
Save Save the IDF file.
Save As Save the IDF file with a new name.
Print Print the IDF file or selected instrument(s).
Print Setup Change the printer and printing options.
Exit Quit IDFEdit; prompts to save unsaved data.



Edit menu commands

The Edit menu offers the following commands:

New Instrument Create a new instrument in the IDF file.
Properties Edit properties of the selected instrument.
Undo Undo the last action.
Redo Redo the previously undone action.
Cut Cut the selected instrument(s) and put it on the Clipboard.
Copy Copy the selected instrument(s) and put it on the Clipboard.
Paste Insert instrument(s) from the Clipboard into the IDF file.

View menu commands

The View menu offers the following commands:

Toolbar Show or hide the toolbar.
Status Bar Show or hide the status bar.

Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index List Help topics.
Using Help Display instructions about how to use help.
About IDFEdit Display program information, version number and copyright.



New command (File menu)

Use this command to create a new IDF file in IDFEdit.    If there is any unsaved data, an 
asterix will appear next to the name of the IDF file in the title bar of the window.    The 
program will then prompt you to save the existing IDF file before it clears all the entries in 
the instrument list.

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing IDF file in the window.    If there is any unsaved data, 
an asterix will appear next to the name of the IDF file in the title bar of the window.    The 
program will then prompt you to save the existing IDF file before it loads the data from the 
new IDF file.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which IDF file to open:
File Name

Type or select the IDF filename you want to open.    This box lists files with the extension 
you select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:

IDF Files
Drives

Select the drive in which IDFEdit stores the IDF file that you want to open. 
Directories

Select the directory in which IDFEdit stores the IDF file that you want to open.
Network...

Choose this button to connect to a network location, assigning it a new drive letter. 



Save command (File menu)

Use this command to save the IDF file to its current name and directory.    When you save an 
IDF file for the first time, IDFEdit displays the Save As dialog box so you can name your IDF 
file.    If you want to change the name and directory of an existing document before you save
it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    IDFEdit displays the Save As 
dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the IDF file you're about 
to save:
File Name

Type a new filename to save the IDF file with a different name.    IDFEdit adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the IDF file.

Directories
Select the directory in which you want to store the IDF file.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Exit command (File menu)

Use this command to end your IDFEdit session.    You can also use the Close command on the
application Control menu.    IDFEdit prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



New Instrument command (Edit menu)

Use this command to create a new instrument in the current IDF file.    You may undo or redo 
this command by selecting the Undo Command or the Redo Command.

Shortcuts

Toolbar:
Keys: CTRL+S



Properties command (Edit menu)

Use this command to access the Property Pages of the instrument. The Property Pages allows 
you to start editing the properties of the selected instrument. This command will only be 
enabled when you have selected an instrument.    You may undo or redo the property 
changes to an instrument by selecting the Undo Command or the Redo Command.

Shortcuts

Toolbar:
Keys: CTRL+S



Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.    If it is not possible to undo 
the last editing action, the command will be grayed out. There are 100 levels of undo at this 
stage. The following commands can be undone :

New Instrument
Properties
Redo
Cut
Paste

Shortcuts
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

Use this command to redo the previously undone editing action, if possible.    If it is not 
possible to redo the previously undone editing action, the command will be grayed out.    
There are 100 levels of undo at this stage. The following commands can be undone :

New Instrument
Properties
Undo
Cut
Paste

Shortcuts
Keys: CTRL+A



Cut command (Edit menu)

Use this command to remove the currently selected instrument(s) from the IDF file and put it
on the clipboard.    This command is unavailable if there is no instrument currently selected.   
You may undo or redo the cut by selecting the Undo Command or the Redo Command.

Cutting instruments to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected instrument(s) onto the clipboard.    This command is 
unavailable if there is no instrument currently selected.
 
Copying instruments to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard instruments into the IDF file.    This 
command is unavailable if the clipboard is empty. If the same instrument name exists 
already, the instrument will be appended with a modified name.    You may undo or redo the 
paste by selecting the Undo Command or the Redo Command.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in IDFEdit, such as File Open.    A check mark appears next to the 
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in IDFEdit,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Create a new IDF file.

Open an existing IDF file.    IDFEdit displays the Open dialog box, in which you can 
locate and open the desired IDF file.

Save the IDF file.    If you have not named the document, IDFEdit displays the Save As 
dialog box. Icon will be grayed out when there is no new data to be saved.

Create a new instrument in the IDF file.

Edit properties of the selected instrument.

Cut the selected instrument(s) and put it on the Clipboard.

Copy the instrument(s) to the clipboard.

Insert instrument(s) from the Clipboard into the IDF file.

Print the IDF file or selected instrument(s).



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the IDFEdit window.    To display or hide the 
status bar, use the Status Bar command in the View menu.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
IDFEdit.



Context Help command 

Use the Context Help command to obtain help on some portion of IDFEdit.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the IDFEdit window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title bar

The title bar is located along the top of a window.    It contains the name of the application, 
IDFEdit, and the currently opened IDF file.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (System menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (System menu)

Use this command to reduce the IDFEdit window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Close command (System menu)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: ALT+F4 closes the IDFEdit window or dialog box



Restore command (System menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>







Print command (File menu)

Use this command to print the IDF file or selected instruments.    This command presents a 
Print dialog box, where you may specify the range of pages to be printed, the number of 
copies, the destination printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the instruments should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints all instruments in the IDF file.
Pages Prints the range of pages you specify in the From and To boxes. 

Each instrument generates 4 pages of data, so if you selected only
one instrument to print, there will be a range of 1 to 4 pages to 
print. Two instruments selected will have 1 to 8 pages, and so 
forth.

Copies
Specify the number of copies you want to print for the above page range.



Print Progress Dialog

The Printing dialog box is shown during the time that IDFEdit is sending output to the printer.
The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.







ID Property Page

The ID Property Page allows the name of the instrument to be edited and the instrument to be set as 
default in the IDF file

Instrument Name
Edit the contents of this box to change the name of the instrument. The last action can 
be undone in the edit box by pressing control-Z keys together.

Set as default
Checking this button specifies that this instrument is to be used if the user selects this 
file but does not specify any instrument within the file.

OK
Click on this button to accept the changes made to all the property pages, and return to 
the main screen. All the changes made to this instruments properties after the OK button
has been clicked can be undone or redone by selecting the Undo Command or the Redo 
Command in the main screen.

Cancel
Click on this button to discard the changes made to all the property pages, and return to 
the main screen.

Apply
Not implemented.

Help
Click on this button to access this help page.



Map Property Pages (Patch map, Key map & Percussion map)

The Patch map, Key map and Percussion map property pages allow the mapping of the 
standard General MIDI Sound Set, Note Numbers and Percussion sounds to custom values 
for a specific MIDI device. The columns in the listbox lists the following items :

The first column contains either an asterisk or nothing. If there is an asterisk, it denotes that 
the value in the Map To column has not been modified from the original General MIDI 
definition. The second column lists the index of the row, while the third column shows the 
General MIDI equivalent for the index. The last column, Map To, displays the value in which 
this index has been mapped to.

Modifying the Map To values
To modify the Map To values, at least one row has to be selected from the list. To select 
multiple rows, click and drag the mouse pointer over the items to be selected. Holding 
the control key down while clicking on items will allow you to select discontinuous items. 
After selecting the item(s), you may either click on your right mouse button and select 
Edit on the popup menu,

or click on the Edit button on the right of the window. This will bring up the following 
dialog :

Enter the value you want to map this index to in the edit box, and all the selected rows in
the list will be changed to this value.



Copying and Pasting Map To Values
Map To values can be copied to and pasted from the Clipboard. This is useful in 
duplicating sets of Map To values, copying them to another IDFEdit document, or even to 
another application such as Excel or Word. However, you may not copy and paste from 
two different maps, such as from Patch map to the Key map. To copy Map To values into 
the Clipboard, select at least one row from the list. Click on the right mouse button and 
select Copy from the popup menu. If the selection is discontinuous, only the items in the 
first set of continuous selected rows will be copied into the Clipboard.

To paste Map To Values from the Clipboard, select a row where the value(s) is to start and
click on the right mouse button and select Paste from the popup menu.

Undo and Redo
All actions to change the Map To values can be undone and redone. There are unlimited 
levels of undo and redo in this property page. If there are no actions to be undone or 
redone, the corresponding buttons will be invalid.

Default
Click on this button to reset all Map To values to the default values.

OK
Click on this button to accept the changes made to all the property pages, and return to 
the main screen. All the changes made to this instruments properties after the OK button
has been clicked can be undone or redone by selecting the Undo Command or the Redo 
Command in the main screen.

Cancel
Click on this button to discard the changes made to all the property pages, and return to 
the main screen.

Apply
Not implemented.

Help
Click on this button to access this help page.



Channels Property Page
The Channels property page allows you to mute channels and select a drum channel. There 
can only be one drum channel.

Selecting and deselecting Mute Channels
To select or deselect a mute channel, simply click on the mute button for that channel to 
toggle it. A check in the box denotes that that channels is muted. When a channel is 
muted, the corresponding drum button is invalidated.

Selecting a Drum Channel
To select a drum channel, simply click on the drum button for that channel to select it. 
The previously selected drum channel should now be deselected. If the drum channel is 
invalidated, you may not select that channel as a drum channel until you un-mute it. 
However, you may mute a channel that is already selected as drum. In this case, 
however, the instrument will be saved with its mute specified, but the drum selection on 
this channel is discarded.

Undo and Redo
All actions to change the mute and drum channels can be undone and redone. There are 
unlimited levels of undo and redo in this property page. If there are no actions to be 
undone or redone, the corresponding buttons will be invalid.

OK
Click on this button to accept the changes made to all the property pages, and return to 
the main screen. All the changes made to this instruments properties after the OK button
has been clicked can be undone or redone by selecting the Undo Command or the Redo 
Command in the main screen.

Cancel
Click on this button to discard the changes made to all the property pages, and return to 
the main screen.

Apply
Not implemented.

Help
Click on this button to access this help page.



Info Property Page

The Info Property Page allows the Version, Creator, Manufacturer, Product ID, Product Revision and 
Product Name fields of the instrument to be edited.

OK
Click on this button to accept the changes made to all the property pages, and return to 
the main screen. All the changes made to this instruments properties after the OK button
has been clicked can be undone or redone by selecting the Undo Command or the Redo 
Command in the main screen.

Cancel
Click on this button to discard the changes made to all the property pages, and return to 
the main screen.

Apply
Not implemented.

Help
Click on this button to access this help page.



Property Pages

Click on the tabs on the top of the window to access the desired page for editing properties.  
The instrument property pages offers the following pages for editing :

ID Edit the name of the instrument and set instrument as default in IDF file.
Info Edit the Version, Creator, Manufacturer, Product ID, Product Revision and 

Product Name fields of the instrument.
Patch Map Redefine instrument mappings from the General MIDI Sound Set.
Key Map Redefine key mappings from the General MIDI Note Numbers.
Drum Map Redefine drum instrument mappings from the General MIDI Percussion Set.
Channels Choose the drum channel and allows muting of channels.






